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Dragi mladi, 

 

Svi mi živimo u svetu u kojem je tehnologija postala ključna za 

svakodnevni život. Računari, internet i društvene mreže nisu samo alatke 

za zabavu i komunikaciju, već i sredstva koja nam omogućavaju da se 

obrazujemo, pronađemo posao, razvijamo veštine i gradimo bolju 

budućnost. Ako ste deo vulnerabilnih grupa i nemate formalne 

kvalifikacije, možda osećate da je teško da se snađete na tržištu rada ili 

da ostvarite svoje ciljeve. Međutim, dobra vest je da ste upravo sada u 

prilici da steknete veštine koje vam mogu otvoriti mnoga vrata – i to bez 

potrebe da čekate. 

Jedna od najvažnijih veština koju možete savladati je kompjuterska 

pismenost, tj. osnovno poznavanje rada sa računarima i najvažnijim 

programima kao što su Microsoft Office alati. Ove veštine nisu samo 

korisne u potrazi za poslom, već će vam pomoći da postanete 

samopouzdaniji i efikasniji u svakodnevnom životu. 

 

 

 

 

 

 



Zašto je danas važno biti kompjuterski pismen? 

U današnjem digitalnom svetu, kompjuterska pismenost je postala 

ključna veština koja se ne odnosi samo na rad sa računarima, već i na 

sposobnost korišćenja raznih tehnologija koje nas okružuju. Biti 

"kompjuterski pismen" znači imati osnovno razumevanje računarskih 

sistema, softverskih aplikacija i interneta, kao i sposobnost da se koristi 

tehnologija za rešavanje problema, obavljanje zadataka i komunikaciju. 

Ovaj nivo pismenosti postao je gotovo jednako važan kao što su to bile 

pismenost u čitanju i pisanju u prošlim vremenima. Bez osnovnog 

poznavanja računara, teško je uspešno funkcionisati u savremenom 

društvu, bilo da se radi o obrazovanju, poslu, svakodnevnim životnim 

obavezama ili jednostavnom pristupu informacijama. 

Tehnologija je prisutna u gotovo svakom aspektu našeg života. Internet 

omogućava pristup neograničenim informacijama, dok se računari 

koriste za obavljanje različitih zadataka — od obrade podataka u 

poslovnim organizacijama, preko učenja na mreži, do zabave i društvene 

interakcije. Savladavanje računarskih veština ne znači samo naučiti kako 

da koristimo uređaje, već i da budemo sigurni i odgovorni u digitalnom 

svetu. 

U ovom priručniku, cilj nam je da vas uputimo na osnovne komponente 

kompjuterske pismenosti koje će vam omogućiti da se snađete u 

svakodnevnim zadacima, poboljšate svoju produktivnost, povećate 

sigurnost na internetu i, uopšte, postanete samopouzdaniji u korišćenju 

tehnologije u životu i poslu. 



Zašto je važno učiti Microsoft Office? 

Microsoft Office je paket programa koji se koristi u skoro svim 

kancelarijama, školama, organizacijama i firmama širom sveta. Bez 

obzira na to koji posao želite da radite, osnovno poznavanje programa 

poput Word-a, Excel-a i PowerPoint-a može biti presudno da biste dobili 

posao, napredovali u karijeri ili čak započeli sopstveni biznis. 

Šta možete da postignete učenjem Microsoft Office-a? 

 

1. Povećate šanse za zapošljavanje 

Mnogo poslodavaca zahteva osnovno poznavanje Word-a (za pisanje 

izveštaja, dopisa, i drugih dokumenata), Excel-a (za praćenje podataka, 

izradu tabela i analiza), i PowerPoint-a (za pripremu prezentacija). Ako 

naučite kako da koristite ove programe, bićete konkurentniji na tržištu 

rada, čak i ako nemate formalnu školu. 

 

 

 



2. Radite efikasnije i produktivnije 

Bilo da ste u potrazi za poslom, volontirate ili učite, osnovno poznavanje 

ovih alata pomoći će vam da organizujete svoje vreme, praćenje zadataka, 

izveštaje i kontakte. Na primer, Excel može da vam pomogne da 

organizujete lične finansije, pratite troškove i planirate budžet. 

3. Kreirate i delite sadržaj 

Uz Word možete pisati i uređivati tekstove, CV-jeve (životopise), 

motivacijska pisma, a uz PowerPoint možete izrađivati prezentacije i 

deliti ideje sa drugima na vrlo profesionalan način. 

4. Poboljšate sposobnost komunikacije 

Outlook i drugi alati za e-mail omogućavaju vam da komunicirate sa 

potencijalnim poslodavcima, kolegama ili mentorima na efikasan i 

organizovan način. Učenje kako da koristite e-mail i kako da organizujete 

sastanke može vam otvoriti mnoga vrata. 

5. Otvorite mogućnosti za samostalno preduzetništvo 

Ako želite da pokrenete vlastiti biznis, Microsoft Office će vam pomoći 

da kreirate poslovne planove, finansijske tabele, izveštaje i marketing 

materijale. Takođe, možete koristiti ove alate za izradu online sadržaja, 

kao što su blogovi, flajeri, i brošure, koje možete deliti na internetu. 

 

 

 



Kako da počnete? 

Početak može da deluje zastrašujuće, ali važno je da znate da je svaki 

korak napredak. Nema potrebe za prethodnim iskustvom – početnici 

mogu učiti osnovne funkcije korak po korak. Takođe, postoje besplatni 

tutorijali i kursevi online koji su prilagođeni početnicima, pa čak i onima 

koji nikada ranije nisu radili sa računarima. Dobar način da započnete je 

da: 

1. Učite osnovne funkcije Microsoft Word-a: Naučite kako da pišete, 

formatirate tekstove, koristite šablone, umetnete slike i tabele. To 

je osnova za većinu poslova i školski zadatke. 

2. Savladajte Microsoft Excel: Naučite kako da unosite podatke u 

tabele, koristite osnovne formule, pravite liste i analizirate podatke. 

Ovo je veština koja je vrlo cenjena u poslovnom svetu. 

3. Naučite kako da kreirate prezentacije u PowerPoint-u: Ako želite 

da pokažete svoje ideje na profesionalan način, znanje PowerPoint-

a će vam omogućiti da kreirate jasan i vizuelno atraktivan sadržaj. 



4. Upoznajte se sa e-mailom i osnovnim alatima za komunikaciju: 

Naučite kako da šaljete, primate i organizujete e-mailove, kako da 

planirate sastanke i pratite obaveze. 

 

Zašto je ovo važno za vas? 

Bez obzira na to iz kojeg društvenog ili ekonomskog okruženja dolazite, 

poznavanje Microsoft Office-a može vam pomoći da: 

• Povećate svoje šanse za zapošljavanje i postanete konkurentniji 

na tržištu rada. 

• Osvojite nove veštine koje su tražene u mnogim industrijama i 

sektorima, uključujući administraciju, prodaju, obrazovanje, 

marketing i mnoge druge. 

• Postanete samostalni i organizovani u svakodnevnim životima, 

bilo da je u pitanju vođenje ličnih finansija, organizacija zadataka 

ili komunikacija sa drugima. 

• Stvorite prilike za preduzetništvo i možda započnete svoj vlastiti 

biznis. 

 

 



Zaključak: 

Učenje Microsoft Office-a nije samo korisno – to je ulaganje u vašu 

budućnost. Bez obzira na vašu trenutnu situaciju ili pozadinu, ovaj skup 

veština vam može pomoći da se povežete sa širim svetom, da postanete 

konkurentniji na tržištu rada i da postignete ciljeve koje ste sebi postavili. 

Važno je da verujete u sebe, da nastavite da učite i da koristite svaku 

priliku za rast i razvoj. Počnite danas – vaša budućnost može biti mnogo 

svetlija uz ove veštine! 

Uvod u Microsoft Office paket 

Microsoft Office je skup aplikacija koje su dizajnirane da vam pomognu 

u obavljanju svakodnevnih poslovnih i ličnih zadataka. Uključuje 

najpoznatije alate kao što su Word, Excel, PowerPoint, i Outlook, koji 

omogućavaju stvaranje dokumenata, rad sa podacima, izradu prezentacija 

i upravljanje e-mailovima. 

Za početnike, Office može delovati kao veliki skup funkcija, ali 

razumevanje osnovnih alata i opcija može uveliko poboljšati vašu 

produktivnost i učiniti svakodnevni rad mnogo lakšim. 

 



1. Microsoft Word – Uvod u program za obradu teksta 

Šta je Microsoft Word? 

Microsoft Word je najpopularniji program za obradu teksta. Koristi se za 

kreiranje, uređivanje i formatiranje različitih vrsta dokumenata, kao što 

su izveštaji, pisma, novinski članci, CV-jevi i mnogi drugi tekstualni 

sadržaji. Word omogućava korisnicima da lako uređuju tekst, dodaju 

slike, tabele i grafikone, kao i da koriste različite stilove i formate za 

prezentaciju informacija. 

Zašto koristiti Microsoft Word? 

Word je jednostavan za korišćenje, ali i vrlo moćan program koji vam 

omogućava da radite sa složenim dokumentima. Bez obzira da li samo 

kucate jednostavan tekst ili pravite opsežan izveštaj sa različitim 

sekcijama, Word je izuzetno fleksibilan i prilagodljiv. 

2. Microsoft Word – Osnove pisanja i formatiranja 

Otvoriti Word: 

1. Kliknite na Start dugme (ikona Windows u donjem levom kutu 

ekrana). 

2. Upišite „Word” u pretragu i pritisnite Enter. 



 

Osnovne funkcionalnosti: 

1. Kreiranje novog dokumenta  

Kada otvorite Word, možete odmah započeti sa pisanjem. Ako želite novi 

dokument, kliknite na File (Fajl) > New (Novi). 



 

2. Pisanje teksta 

Jednostavno kucajte tekst na tastaturi. Za razmak koristite taster Space. 

3.Formatiranje teksta 

 Bold (podebljani tekst) - Ctrl + B. 

 Italic (kurziv) - Ctrl + I. 

 Underline (podvlačenje) - Ctrl + U. 

4.Font i veličina 

Kliknite na padajući meni sa fontovima i izaberite željeni font i veličinu. 

 

 

 

 

 



5.Boja teksta 

Kliknite na ikonu boje u vrhu ekrana da promenite boju teksta. 

 

 

 

 

 

 

6.Poravnanje 

Levo poravnanje: Kliknite na Align Left. 

Desno poravnanje: Kliknite na Align Right. 

Centrirano: Kliknite na Center. 

 

7.Snimanje dokumenta 

 Kliknite na File > Save (ili pritisnite Ctrl + S) da biste sačuvali 

dokument. 

 Odaberite lokaciju na svom računaru gde želite da sačuvate 

dokument. 

 

 



8.Dodavanje slika 

1. Kliknite na Insert (Umetni) u gornjoj traci. 

2. Odaberite Pictures (Slike) i pronađite sliku na svom računaru. 

 

 

 

 

 

 

 

 

 

 



3. Microsoft Excel – Uvod u rad sa tabelama i podacima 

Šta je Microsoft Excel? 

Microsoft Excel je aplikacija koja se koristi za rad sa tabelama, 

proračunskim listovima i podacima. Excel je najpoznatiji alat za analizu 

podataka i obavljanje matematičkih operacija. Koristi se u različitim 

industrijama, od finansija do nauke, za organizaciju podataka, kreiranje 

grafikona, pravljenje budžeta i analiza. 

 

Zašto koristiti Microsoft Excel? 

Excel je izuzetno moćan za rad sa velikim količinama podataka. 

Omogućava korišćenje formula, izračunavanja, sortiranja, filtriranja, kao 

i vizualizaciju podataka putem grafikona. Bilo da unosite jednostavne 

brojeve ili radite sa složenim analizama, Excel vam omogućava da brzo 

obradite podatke i dobijete tačne rezultate. 

 



Microsoft Excel 

Osnovne funkcionalnosti za rad sa tabelama 

Otvoriti Excel: 

Kliknite na Start dugme, upišite „Excel” i pritisnite Enter. 

 

Osnovne funkcionalnosti 

Unos podataka 

U ćelijama (kvadrati sa oznakama, npr. A1, B1) možete unositi brojeve, 

tekst ili datume. 



 

Osnovne operacije sa podacima 

 Zbrajanje: Kliknite na ćeliju u kojoj želite rezultat i napišite 

=SUM (A1:A10) da biste zbrojili vrednosti u ćelijama A1 do A10. 

 Prosečna vrednost: =AVERAGE (A1:A10). 

Formatiranje ćelija 

 Desni klik na ćeliju > Format Cells (Format ćelija) > Izaberite 

vrstu formata (npr. valuta, datum, broj). 

Dodavanje novih redova i kolona 

 Kliknite desnim tasterom miša na broj reda ili slovo kolone i 

odaberite Insert (Umetni) za dodavanje novog reda ili kolone. 

Snimanje rada 

 Kliknite na File > Save ili pritisnite Ctrl + S da sačuvate svoj rad. 



4.Microsoft PowerPoint - Uvod u izradu prezentacija 

Šta je Microsoft PowerPoint? 

Microsoft PowerPoint je alat za kreiranje vizuelno atraktivnih 

prezentacija. Koristi se za predstavljanje informacija u obliku slajdova, 

koji mogu sadržavati tekst, slike, grafike, video zapise i animacije. 

PowerPoint je često korišćen u poslovnim prezentacijama, obrazovnim 

okruženjima i na konferencijama. 

 

Zašto koristiti Microsoft PowerPoint? 

PowerPoint je vrlo moćan alat za prenošenje informacija na vizuelan 

način. S njegovim jednostavnim interfejsom, možete brzo napraviti 

profesionalne prezentacije koje će vaše ideje i podatke učiniti jasnijim i 

zanimljivijim za publiku. Efekti animacija, transition i mogućnost 

umetanja multimedijalnih sadržaja čine PowerPoint idealnim za vizualne 

prezentacije. 

 



Microsoft PowerPoint – Osnove za kreiranje prezentacija 

Otvoriti PowerPoint: 

Kliknite na Start, upišite „PowerPoint” i pritisnite Enter. 

 

Osnovne funkcionalnosti: 

Kreiranje nove prezentacije  

Po pokretanju PowerPoint-a, izaberite opciju Blank Presentation (Prazna 

prezentacija). 



 

Dodavanje novih slajdova: Kliknite na Home > New Slide (Novi slajd) 

i izaberite tip slajda (npr. naslovni, tekstualni). 

Unos teksta: Kliknite na kutiju za tekst i počnite da kucate. 

Dodavanje slika, grafikona i oblika: Kliknite na Insert > Pictures 

(slike), Shapes (oblik) ili Chart (grafikon). 

Efekti prelaza i animacije: Kliknite na Transitions (Prelazi) u gornjoj 

traci da biste dodali animacije između slajdova. 

Kliknite na Animations (Animacije) da biste dodali animacije za tekst ili 

objekte unutar slajda. 

Pokretanje prezentacije: Kliknite na Slide Show > From Beginning 

(Počni od početka) ili pritisnite F5. 



 

5. Microsoft Outlook – Uvod u rad sa e-mailovima i kalendarima 

Šta je Microsoft Outlook? 

Microsoft Outlook je najpoznatiji program za upravljanje e-mailovima, 

kontaktima, kalendarima i zadacima. Outlook se koristi za slanje i 

primanje e-mailova, zakazivanje sastanaka, postavljanje podsetnika i 

organizaciju poslovnih aktivnosti. 



Zašto koristiti Microsoft Outlook? 

Outlook nije samo alat za slanje e-mailova, već i kompletan organizator 

koji vam pomaže da se bavite svim aspektima vaše profesionalne i lične 

organizacije. Njegova integracija sa kalendarima omogućava 

jednostavno zakazivanje sastanaka, a menadžment zadataka pomaže u 

praćenju svakodnevnih obaveza. Takođe, Outlook je vrlo koristan za 

poslovnu komunikaciju jer podržava grupne e-mailove i efikasnu 

arhivaciju poruka. 

Naravno! Ispod je priručnik za rad u Microsoft Officeu koji je prilagođen 

za početnike. Obuhvatiću osnovne funkcionalnosti najčešće korišćenih 

aplikacija kao što su Word, Excel, PowerPoint i Outlook. 

Microsoft Outlook – Osnove za rad sa e-mailovima 

Otvoriti Outlook: 

Kliknite na Start, upišite „Outlook” i pritisnite Enter. 

Osnovne funkcionalnosti: 

Pisanje novog e-maila: 

Kliknite na New Email (Novi e-mail) u gornjoj traci. 

Unesite adresu primaoca u polje To (Primaoci), temu u Subject 

(Predmet), i tekst poruke u telo e-maila. 

Kliknite na Send (Pošaljite) kada završite. 

 

 



Odgovaranje na e-mail: 

Kliknite na Reply (Odgovori) ili Reply All (Odgovori svima) da biste 

odgovorili na poruku. 

Dodavanje priloga: 

Kliknite na Attach File (Priloži fajl) i izaberite fajl sa svog računara. 

Kreiranje kalendara i zakazivanje sastanaka: 

Kliknite na Calendar (Kalendar) u donjem levom kutu. 

Kliknite na New Appointment (Novi sastanak) da biste zakazali događaj. 

Saveti za efikasno korišćenje Office alata: 

1.Kratice na tastaturi: Korišćenje tastaturskih prečica može vam 

značajno uštedeti vreme. Na primer: 

 Ctrl + C – Kopiraj 

 Ctrl + V – Zalepi 

 Ctrl + X – Iseci 

 Ctrl + Z – Poništi 

 Ctrl + P – Štampanje 

2.Organizacija dokumenata: Redovno organizujte svoje dokumente u 

fascikle kako biste lakše pronašli šta vam treba. 

3.Redovno snimanje: Obavezno često snimajte svoj rad, kako biste 

izbegli gubitak podataka. 

4.Upotreba predložaka: Ako nemate mnogo vremena, Office nudi 

veliki broj predložaka za izveštaje, CV-jeve, prezentacije i sl. 



Svaki od ovih programa ima ključnu ulogu u svakodnevnom poslovanju 

i ličnoj produktivnosti. Razumevanje njihovih osnovnih funkcionalnosti 

omogućava efikasno korišćenje, a uz dalji rad i učenje, bićete u 

mogućnosti da koristite napredne opcije i funkcionalnosti koje Microsoft 

Office nudi. 

 

 

 

 

 

 

 

 



 

Pre nego što započnete izradu sajta u WordPressu, korisno je da imate 

određena predznanja i veštine u oblasti IT-a i web dizajna. WordPress je 

veoma user-friendly i omogućava kreiranje sajtova čak i onima sa 

minimalnim tehničkim znanjem, ali ako imate osnovne tehničke veštine, 

to će vam značajno olakšati rad i omogućiti veći stepen kreativnosti i 

kontrole nad projektom. 

Evo šta biste trebali da savladate pre nego što krenete sa izradom sajta u 

WordPressu: 

 

 

 



6. Osnovno razumevanje rada interneta i web tehnologija 

Zašto je važno? Razumevanje osnovnih principa rada interneta i kako 

funkcionišu web stranice pomoći će vam da bolje razumete kako se vaš 

sajt postavlja, održava i upravlja njime. 

Šta je domen i hosting? 

Domen je adresa vašeg sajta na internetu (npr. www.mojsajt.com). 

Hosting je usluga koja omogućava da vaš sajt bude dostupan na internetu. 

Trebalo bi da znate kako da odaberete odgovarajući hosting paket (npr. 

deljeni hosting, VPS, ili WordPress specifični hosting). 

HTTP i HTTPS protokoli 

Razumeti razliku između HTTP (HyperText Transfer Protocol) i HTTPS 

(HyperText Transfer Protocol Secure). HTTPS koristi šifrovanje, što je 

važno za sigurnost sajta. 

Web browser i osnovni alati za testiranje 

Znanje kako da koristite različite web preglednike (Chrome, Firefox, 

Edge) i alatke za ispitivanje (npr. alatke za razvoj u preglednicima poput 

Inspect Element) kako biste analizirali izgled i ponašanje sajta. 

7. Osnovno poznavanje HTML-a i CSS-a 

Zašto je važno? Iako WordPress omogućava izradu sajta bez potrebe za 

pisanjem koda, poznavanje osnova HTML-a i CSS-a može vam pomoći 

da razumete kako WordPress generiše stranicu, a takođe će vam 

omogućiti da prilagodite izgled i strukturu sajta kada to bude potrebno. 



HTML (HyperText Markup Language) 

Osnovna struktura web stranice je napisana u HTML-u. Trebalo bi da 

razumete osnovne HTML tagove kao što su <h1>, <p>, <a>, <img>, 

<div>, <span> itd. 

CSS (Cascading Style Sheets) 

CSS je zadužen za stilizovanje vašeg sajta. Trebalo bi da naučite osnovne 

CSS stilove za pozadinske boje, fontove, razmake, veličinu slika i druge 

vizualne elemente. 

Responsive dizajn 

Razumevanje osnova responsivnog dizajna je ključno, jer ćete želeti da 

vaš sajt bude prilagodljiv za mobilne uređaje i tablete. Ovo podrazumeva 

korišćenje medijskih upita (@media queries) za prilagođavanje rasporeda 

stranica. 

8. Osnovno poznavanje sistema za upravljanje sadržajem (CMS) 

Zašto je važno? WordPress je CMS (Content Management System), što 

znači da omogućava upravljanje sadržajem bez potrebe za kodiranjem. 

Međutim, razumevanje kako CMS funkcioniše i kako se koristi može 

ubrzati proces izrade sajta. 

Razumevanje osnovnih funkcija WordPressa: 

Kreiranje i upravljanje stranicama i postovima – Znanje kako da 

kreirate statične stranice (npr. "O nama", "Kontakt") i dinamične postove 

(blog postove). 



Rad sa menijima – Kako kreirati i organizovati menije u WordPressu. 

Instalacija i konfiguracija tema i plugina – Razumevanje kako da 

odaberete i prilagodite teme i dodate funkcionalnost putem plugina. 

9. Poznavanje osnovnih SEO principa 

Zašto je važno? SEO (Search Engine Optimization) je ključ za 

poboljšanje vidljivosti vašeg sajta na pretraživačima kao što je Google. 

Poznavanje osnovnih SEO tehnika pomoći će vam da vaš sajt bude lakše 

pronađen i rangiran. 

Osnovni SEO principi: 

Optimizacija za ključne reči – Razumevanje kako da koristite 

relevantne ključne reči u naslovima, tekstovima, URL-ovima i 

metapodacima. 

Struktura URL-a – Znanje kako postaviti čiste i SEO-prijateljske 

URL-ove (npr. www.mojsajt.com/o-nama umesto 

www.mojsajt.com/page?id=123). 

Upotreba alt tagova za slike – Dodavanje deskriptivnih alt tagova za 

slike radi boljeg rangiranja u pretrazi slika i boljeg pristupačnosti. 

Rad sa WordPress administrativnim panelom 

Zašto je važno? Razumevanje WordPress administrativnog panela je 

ključno za upravljanje svim aspektima sajta, od sadržaja do postavki i 

funkcionalnosti. 



Dashboard: Upoznajte se sa osnovnim funkcijama WordPress 

Dashboard-a (kontrolne table) kao što su: 

 Dodavanje novih postova i stranica. 

 Postavljanje i menjanje teme. 

 Instalacija i aktivacija plugina. 

 Podešavanje postavki sajta (npr. jezik, vremenska zona, 

permalink struktura). 

Razumevanje sigurnosti sajta 

Zašto je važno? Sigurnost je od najveće važnosti za svaki sajt, jer 

WordPress sajtu može biti meta cyber napada. Razumevanje osnovnih 

bezbednosnih praksi može zaštititi vaš sajt od hackovanja i drugih 

problema. 

Upotreba jakih lozinki i autentifikacija – Učenje o sigurnim lozinkama 

i dvofaktorskoj autentifikaciji. 

Sigurnosni pluginovi – Upoznavanje sa pluginovima za sigurnost kao 

što su Wordfence, iThemes Security itd. 

Redovno ažuriranje WordPressa, tema i plugina – Razumevanje 

važnosti održavanja sistema ažuriranim kako bi se smanjili sigurnosni 

rizici. 



9. Osnovno poznavanje grafičkog dizajna i alata za dizajn 

Zašto je važno? Dobar dizajn je ključ za privlačenje posetilaca i njihovo 

zadržavanje. Osnovno poznavanje grafičkog dizajna će vam pomoći da 

kreirate privlačan i funkcionalan sajt. 

Razumevanje osnovnih principa dizajna: Kompozicija, boje, 

tipografija, kontrast i raspored. 

Alati za grafiku: Poznavanje alata poput Canva ili Adobe Photoshop za 

kreiranje slika i grafika koje ćete koristiti na sajtu. 

Optimizacija slika za web: Smanjivanje veličine slika bez gubitka 

kvaliteta kako bi se ubrzao učitavanje sajta. 

Zaključak 

Iako WordPress omogućava izradu sajtova bez dubokog tehničkog 

znanja, osnovne IT veštine i razumevanje ključnih koncepata mogu 

značajno unaprediti kvalitet sajta i ubrzati proces izrade. Učenje ovih 

osnovnih veština, kao što su HTML, CSS, SEO, rad sa WordPress 

administrativnim panelom i sigurnost sajta, omogućit će vam da 

napravite sajt koji je profesionalan, funkcionalan i siguran. 

 



Uputstvo za izradu sajta u WordPress-u za početnike 

Prvi koraci: Šta vam je potrebno 

Pre nego što započnete izradu sajta, morate se pobrinuti za nekoliko 

osnovnih stvari: 

1. Domen: Domen je adresa vašeg sajta (npr. www.mojsajt.com). 

Možete ga kupiti putem kompanija koje nude registraciju 

domena, kao što su GoDaddy, Namecheap ili Bluehost. 

2. Web hosting: Web hosting je prostor na internetu gde će biti 

smešteni svi podaci vašeg sajta (slike, tekst, fajlovi, itd.). Neki 

popularni hosting provajderi su Bluehost, SiteGround i 

HostGator. 

3. Instalacija WordPress-a: Mnogi hosting provajderi nude opciju 

"jednog klika" instalacije WordPress-a, što znači da ne morate da 

brinete o tehničkim detaljima – WordPress će biti automatski 

instaliran na vaš hosting. 

Prijava u WordPress 

1. Nakon što ste instalirali WordPress, prijavite se na vašu 

administrativnu kontrolnu tablu. 

2. Otvorite internet pretraživač i upišite 

www.vašdomen.com/wp-admin. 

3. Unesite korisničko ime i lozinku koje ste postavili prilikom 

instalacije WordPress-a. 

4. Kliknite na Login (Prijava). 

 



Osnove WordPress interfejsa 

Nakon što se prijavite, bićete prebačeni u WordPress Dashboard 

(kontrolnu tablu). Ovo je glavni ekran gde ćete upravljati svim aspektima 

vašeg sajta. 

Na levoj strani nalaziće se meni sa opcijama kao što su: 

• Posts (Objave) – za kreiranje blog postova. 

• Pages (Stranice) – za kreiranje statičkih stranica (npr. "O nama", 

"Kontakt"). 

• Appearance (Izgled) – za izbor teme i prilagođavanje dizajna 

sajta. 

• Plugins (Dodaci) – za instalaciju dodatnih funkcionalnosti. 

• Settings (Podešavanja) – za osnovna podešavanja sajta. 

Izbor teme 

Jedan od prvih koraka u kreiranju sajta je izbor odgovarajuće teme. Tema 

određuje izgled vašeg sajta, kako će biti raspoređeni elementi i koja će 

biti osnovna paleta boja. 

1. U kontrolnoj tabli kliknite na Appearance > Themes (Izgled > 

Temama). 

2. Kliknite na Add New (Dodaj novu) kako biste istražili besplatne 

ili plaćene teme. 

3. Pretražujte teme i kliknite na onu koja vam se dopada. Zatim 

kliknite na Install (Instaliraj), a potom na Activate (Aktiviraj) 

kako biste je postavili kao vašu glavnu temu. 



Kreiranje stranica i postova 

Nakon što ste izabrali temu, možete početi sa kreiranjem sadržaja za vaš 

sajt. 

Kreiranje stranica (Pages): 

1. U kontrolnoj tabli idite na Pages > Add New (Stranice > 

Dodaj novu). 

2. Unesite naziv stranice (npr. "Početna", "O nama", "Kontakt"). 

3. U tekst editoru unesite sadržaj stranice. 

4. Kliknite na Publish (Objavi) da biste objavili stranicu na sajtu. 

Kreiranje postova (Posts): 

1. U kontrolnoj tabli kliknite na Posts > Add New (Objave > 

Dodaj novu). 

2. Unesite naziv posta, tekst i slike koje želite da prikažete. 

3. Kliknite na Publish (Objavi) kada završite. 

Napomena: Stranice su statične (npr. "O nama"), dok su postovi 

dinamični i obično se koriste za blogove i novosti. 

Prilagodite izgled sajta 

Sada je vreme da prilagodite dizajn sajta prema vašim željama. 

1. Idite na Appearance > Customize (Izgled > Prilagodi). 

2. U ovom delu možete promeniti: 

 Logo i slika zaglavlja: Postavite svoj logo ili sliku u 

zaglavlju sajta. 



 Boje i fontove: Prilagodite boje i tipografiju prema vašem 

brendu. 

 Dodavanje widget-a: Dodajte razne widgete kao što su 

poslednji postovi, arhiva, kontakt forma, društvene mreže 

itd. 

 Podnožje (Footer): Uredite podnožje sajta koje se 

pojavljuje na dnu svake stranice. 

Dodavanje funkcionalnosti pomoću dodataka (Plugins) 

WordPress omogućava dodavanje funkcionalnosti vašem sajtu pomoću 

dodataka (plugins). Na primer, možete dodati kontakt formu, SEO 

optimizaciju, bezbednost sajta, galeriju slika i mnoge druge funkcije. 

1. Idite na Plugins > Add New (Dodaci > Dodaj novi). 

2. Pretražujte dodatke po kategorijama ili imenu. Na primer: 

Yoast SEO – za SEO optimizaciju. 

3. Contact Form 7 – za dodavanje kontakt forme. 

4. Jetpack – za unapređenje performansi sajta. 

5. Kliknite na Install (Instaliraj) pored dodatka koji želite, a 

zatim na Activate (Aktiviraj). 

Objavite svoj sajt 

Kada završite sa izradom sajta i dodate sav potrebni sadržaj, vreme je da 

objavite sajt i učinite ga dostupnim svetu. 

1. Pre nego što objavite, proverite sve stranice i postove. 

2. Ako želite da vaša stranica bude odmah dostupna, u Settings 

> Reading (Podešavanja > Čitanje), proverite opciju Your 

homepage displays (Vaša početna stranica prikazuje), da biste 

odabrali koju stranicu želite da bude početna. 

3. Objavite sajt, a zatim podelite svoj domen sa prijateljima, 

porodicom i na društvenim mrežama! 



Zaključak 

WordPress je izuzetno moćan alat za kreiranje sajtova i blogova, a uz 

ovaj vodič, sada možete početi sa osnovnim koracima izrade sajta. Prvo, 

izaberite temu, zatim kreirajte stranice i postove, prilagodite dizajn, 

dodajte dodatke za nove funkcionalnosti, i na kraju objavite svoj sajt. 

WordPress je jednostavan za upotrebu, ali i vrlo fleksibilan. Kako budete 

napredovali, možete istraživati naprednije opcije, kao što su SEO 

optimizacija, dodavanje e-commerce funkcionalnosti (prodaja 

proizvoda), i kreiranje složenijih stranica. 

 

 

 

 

 



Nikada nije kasno da započnete svoje učenje i razvoj. Kompjuterske 

veštine, kao što je poznavanje Microsoft Office paketa, mogu biti vaša 

ključna prednost u životu. Ove veštine nisu samo za one koji već imaju 

visoko obrazovanje ili radno iskustvo – one su za svakog mladog čoveka 

koji želi da napravi prvi korak ka boljoj budućnosti. 

Svaka nova veština koju naučite donosi vam više mogućnosti – za posao, 

obrazovanje, ili čak za pokretanje sopstvenog preduzetničkog poduhvata. 

Nemojte se obeshrabriti ako nemate formalne kvalifikacije ili ako se 

osećate nesigurno. Svaki dan je prilika da naučite nešto novo, da se 

unapredite i postanete bolja verzija sebe. 

Uzmite računar u ruke, učite, istražujte, i verujte u svoje sposobnosti. 

Vaša budućnost je u vašim rukama. Kroz sticanje novih veština, gradite 

temelje za uspeh koji dolazi. Budite uporni, strpljivi i ne bojte se da 

napravite prve korake. Svaka prepreka je samo prilika da rastete i učite. 

 

 

Srećno na vašem putu!  

Verujte u sebe – svet je pun mogućnosti, a vi ste spremni da ih 

iskoristite! 

 

 

 



  



 


